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INTENDED AUDIENCE 

The following tutorials assume that the reader is a web devel oper 
with certain skills.

Basic web site concepts and technologies such as HTML, web 
browsers, remote web hosting concepts, and the use of tables for 
layout purposes 

Basic Knowledge of Macromedia Dreamweaver is required.  There are 
some very good tutorials included with Dreamweaver.  Investing time 
up-front going through these tutorials will have an immediate payback 
in using Dreamweaver to Revize Enable web sites AND use for normal 
web page design. 
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1 OVERVIEW OF THE REVIZE  

1.1 WHAT IS REVIZE?

What is Revize, and what makes it so great? Revize is an affordable, 
creative answer to today’s content management problems. Giving so 
much more freedom to developers and content editors so they can 
work on real business issues. Revize gives the Content Management 
space what it has always needed, an easy, quickly installed, out of the 
box solution. 

1.2 REVIZE COMPONENTS

The total Revize system consists of the following core components. 

�� Revize publishing Engine

�� Embedded web server supporting JSP pages 

�� Relational Database 

�� Revize Dreamweaver Extension
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1.3 HOW REVIZE WORKS

Revize simply stores the content that has been put into a Database ,
combines it with the Template  that the developer has created to 
produce Published  pages that will display on the website to its 
viewers.

DIAGRAM 1

1.4 UNDERSTANDING TEMPLATES

1.4.1 The Template Advantage 

The concept of Templates for some Web Designers may seem rather 
unprofessional and unmarketable. Giving it a concept of being more of 
a disadvantage than a perk.

So Revize has designed a system for custom templates, which can 
take your pre-existing professionally designed pages and transform 
them into Revize Templates. The Revize system can then track which 
information is editable and which is not, leaving you with less to worry 
about and more freedom to work on what needs to be done. 

Revize technology is Unique
because pages are published 
at the same time that the 
content is Changed and NOT 
every time someone visits 
each page. 

Published pages 
can also contain 
dynamic data. 
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1.4.2 Templates and their Types

Revize has 2 Template types – Unique and Dependent.
Both are very distinctive, and play large roles in creating published web 
pages. In this section we will go over a brief description of each, which 
may help on any confusing factors you may run into.

So what is the difference between a Unique and Dependent Template?

Developer’s Note: One important thing to remember when working with a 
Dependent Template is to create the Unique Template that it will be connected 
with it first.

1.5 WHAT IS REVIZE-ENABLING ?

Revize-enabling, is a rather catchy word that you may find yourself 
saying a lot or at least you will see lot of reference to it in the 
proceeding areas of this tutorial. So what is Revize-Enabling? It is the 
art of making the templates and modules that will allow content to be 
changed. It allows the Editor to add and control the content as needed 
without the technical knowledge or need of the Developer. 

Reminder: As was shown above in the diagram 1, Templates give you the ability 
to see where your content will go on your publish pages.

         Unique Template         Dependent Template 

It is a template that stands 
alone, independent of other 
template or content in the 
database.

It consists of a Template that is
dependent upon another 
Unique Template or a list of 
content.
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1.6 REVIZE GLOSSARY REFERENCE

Here is our Glossary Reference for all of our terms that are used 
throughout this Tutorial. 

1.6.1 Content Editor(s) 

This is the person or persons who actually update content appearing 
on Revize-enabled web pages. The Editor is usually someone with no 
IT or technical web page knowledge. Revize is designed to give 
editorial ability to those closest to the content. 

1.6.2 Editable Content 

This is the information (content) that can be edited on a page managed 
by the Revize Content Management System (CMS).  To use Revize 
effectively, content is given some structure.  For example, a typical 
document or web page consists of a title and body.  The body could be 
further broken up, say, into a date, overview, and detail. 

1.6.3 Revize Document Types 

There are two primary types of Revize documents:  Templates and 
Edit Pages.

Function: display field names; define editable areas of a specific 
page or group of pages.
Templates  define where content from Module fields should be 
located and displayed on a Revize-enabled web page.  A web 
page’s Template is invisible to the Revize end user, the non-
technical Content Editor.

Type:  Templates 

Type:  Edit Pages 

Function: display form fields 
Edit Pages  on the other hand, contain the simple-to-use html-like 
forms by which the Content Editor modifies editable web page 
content (stored behind the scenes in Module Records).  In 
addition to these forms, Edit Pages can display non-editable 
content for reference. 
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Templates and the content entered on Edit Pages combine together 
automatically to create standard published html pages.  Only the 
external site visitors view these end-result published pages.  When a 
Template is updated, the page is automatically regenerated by the 
publishing engine and published across a Channel to the internal or 
external web (or to one’s localhost during development).

Developer’s Note:   Templates are stored within the Revize database, whereas Edit 
Pages are stored outside the database in files with the extension .jsp.  Thus, content 
in Edit Pages may be modified on the local host and sent via FTP to the remote 
server.
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2 HOW TO INSTALL DREAMWEAVER 
EXTENSION

To install the Dreamweaver extension you must first download the 
extension that is specified by your Revize Administrator. You can also 
load it from your Revize Installation CD.

NOTE: Make sure that your Dreamweaver extension is the same build as your build of 
Revize.

2.1 OPENING EXTENSION MANAGER

First open up the extension manager in either 2 ways: 

1. Select your start menu>programs>macromedia>extension 
manager

2. Select the command>extension manager, under the Dreamweaver 
menu bar 

2.2 INSTALLATION PROCESS

The process of installing Dreamweaver is a very simple process. For 
those of you already familiar with the Dreamweaver Extension 
Manager you may want to skip this section. If though you do not feel 
comfortable enough with it, please continue through this brief run 
through of how to install. 

1. Go to your Macromedia Extension Manager: 

Developer’s Note:  Because the extension is rather large, you will need to 
uninstall, and reinstall when updating your Revize extension. 
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Select:
File>Install Extension 

Your screen should appear much like this Figure 

Figure: Select Extension to install (Extension Manager)

2. The select extension to install screen will appear.  Find and select 
the Dreamweaver Extension listed as:
revize.mxp

Click Install. 

3. An Extension Manager Disclaimer window will appear 
Select “Accept” to continue. 

Developer’s Note:  The Installation should begin immediately but may take a few 
moments for the extension to install. 
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4. The installation should continue after this point. When the 
extension manager is complete a window will appear stating that 
the Revize extension has been installed. 

Click OK. 

5. At this point you are now ready to use your Dreamweaver 
Extension.

Go to your start menu> 
Select Dreamweaver 

When Dreamweaver is open you should notice the addition of the 
Revize option under the menu tool bar.
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3 TESTING THE INSTALLATION 

After installing your Revize Dreamweaver Extension in a later version 
of Dreamweaver, it should look something like Figure: Dreamweaver 4 or 
later

Figure: Dreamweaver 4 or later 

If you are running it with Dreamweaver MX, than your menu bar will 
look something like Figure: Dreamweaver MX, below.

Figure: Dreamweaver MX
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Developer’s Tip : You will have to navigate through the Objects window 
categories to obtain the image shown. 

3.1 SETTING UP DREAMWEAVER PREFERENCES:

Suggested Dreamweaver Configuration Settings 

Revize should show up next to the Edit menu item in the main menu 
bar of your Dreamweaver application as shown above.  The 
Dreamweaver Objects window should also have a set of Revize 
objects available as shown above. 

If both of these are present, you have successfully installed the Revize 
Dreamweaver Extension.

When using Dreamweaver to Revize-enable web sites, we suggest 
you change some of the standard Dreamweaver Preferences.  To 
make these changes, select the EDIT MENU and click on PREFERENCES
and then and make changes. 

3.1.1 Preference Changes: 

Category:  General 

Category:  Code Format 

Object Panel:  We recommend using ICONS AND TEXT until you 
have become familiar with the new Revize objects that were 
added to the Dreamweaver objects panel. 

Uncheck AUTOMATIC WRAPPING.  This prevents Dreamweaver 
from chopping up Revize snippets. 
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Category:  Code Rewriting 

Category:  Code Rewriting 

Category:  Site 

UNCHECK ENCODE SPECIAL CHARACTERS IN URL'S USING %.  This 
prevents Dreamweaver from mistakenly treating Revize’s JSP 
comments as a URL and inserting unwanted % escape 
sequences.

UNCHECK WARN WHEN FIXING OR REMOVING TAGS .  This tells 
Dreamweaver to notify you of changes in the HTML. 

ALWAYS STORE LOCAL FILES ON THE LEFT .  This lays out the 
Dreamweaver site window to look like a standard FTP program
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4 GETTING STARTED WITH THE REVIZE 
DREAMWEAVER EXTENSION 

4.1 KNOWING YOUR COMPONENTS

4.1.1 Components of the Revize Dreamweaver Extensio n 

The Revize Dreamweaver Extension consists of three main 
components.

1. Revize menu  
2. Revize objects  
3. Revize Property Inspectors  

4.1.2 The Revize Menu  

The Revize menu is located within the tool menu, and is a useful 
resource when you need specific commands to help Revize-Enable a 
website.

The listed commands on the 
menu help to Set-up 
webSpaces and Modules, To 
Create, Retrieve and Delete 
Templates, and To Create Edit 
Pages and Edit Forms.

The menu also allows for 
Document property changes, 
Warnings Messages, 
Diagnosis, Refresh and Help. 
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4.1.3 Revize Objects 

The Revize Object menu is the most important piece of this extension. 
The Revize Object menu allows Revize code to be added to a Revize 
template.  The Revize Object bar is shown below for Dreamweaver MX 
and Dreamweaver 4. 

Figure: Menu in Dreamweaver MX

Figure: Menu in Dreamweaver 4
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4.1.4 Revize Property Inspectors 

Additional Revize property inspectors are included that can intelligently 
display attributes of Revize objects when they are selected.  A generic 
property inspector used for many Revize objects simply displays the 
behind-the-scenes html code for the selected object.  Here are some 
examples of the Revize Property inspectors. 

Figure: Revize Property Inspector

Figure: Revize Property Code Inspector 

4.1.5 Getting to know the 10 steps of Revize Enabli ng 

The process of Revize enabling can be summarized in the following 10 
steps.  It is important to keep these steps in front of you when you first 
begin Revize enabling your web pages, as you can refer to them when 
you get lost.  The steps can be referenced from the Revize Menu 
under help and printed for easy reference. 

4.1.6 10 Steps to Revize Enable Web Pages 

  Step 1. Define Dreamweaver Site (Site Menu, done only once)

  Step 2. Create Idetix webSpace (Revize Menu, done only once) 

  Step 3. Open a Template (reusable page design) 
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  Step 4. Revize Enable Page (from Revize Menu) 

Step 5. Create Revize Modules (database tables) 
               Revize Menu: Create modules and/or Fields 

Step 6. Place Revize objects on page 
               Dreamweaver Objects Menu (Revize objects) 

Step 7. Store the template in Revize application 
               Revize Menu: Store Updated Template 

Step 8. View updated template 
               Must open browser and point at URL 

Step 9. Create associated Administrative Edit Forms 
               Often Templates can be used to clone edit forms 
               Revize Menu: Convert Revize Document 

Step 10. Repeats steps 3 through 9 for each page design 

4.1.7 Learning and Using the 10 Steps 

For the tutorial lessons that follow, you will use the tutorial site that was 
loaded when you installed the Revize Web Application.  You'll find it 
under:

<Revize Install Directory>\www\revize\tutorial
(default is: C:\Revize\www\revize\tutorial)

This tutorial site is what demositeIII looked like before it was Revize-
enabled.

This tutorial will walk you through the process of Revize-enabling this 
site.  Because a copy of the demositeIII is also installed on your 
computer, you can refer to it to see how you are doing with the lessons 
or use it as a reference to correct any errors you may encounter.

Developer’s Note : A copy of the tutorial directory is included on the Revize CD and 
can be used to reset the tutorial to its original condition, it is also provided as a zip 
file in the tutorial directory.
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You will need to start the Revize application and Dreamweaver to 
begin working. 

�� Start your Local Revize Web Application from the Windows Start 
menu:  Start > Programs > Revize > Start Revize 

�� Start Dreamweaver. Open the new site window by selecting New 
Site from the Site menu. 
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5 REVIZE ENABLING IN DEMOSITE III 

5.1 REVIZE-ENABLE HOME PAGE

The home page will be the first template to Revize Enable.  We will be 
following the 10 Steps to Revize enabling.  The first 2 steps only apply 
to the first template of each web site and/or webSpace. 

5.1.1 Revize Enable Step 1: 
Define A Dreamweaver Site 

Developer’s Tip: For more information on defining a site in 
Dreamweaver look up Defining A Site, in Dreamweaver help. 

Define a site that points to the tutorial directory as shown below:

Revize currently REQUIRES that the local root folder be directly 
underneath the Revize folder as shown above. 
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Figure: Site Window View

CAUTION: If a Dreamweaver Site is NOT defined, absolute paths to your local 
file system may be used for images and hyperlinks, which will not work when 
the pages are deployed on a web server.

For the most part you will be hosting your web site on a remote Revize 
hosting server, by filling in the Remote Info, the information that is 
provided will be used by your IT Department, web hosting, or service 
provider so you can easily transfer working copies of your pages and 
or edit pages to the remote host. 

IMPORTANT DEVELOPER’S NOTE: This step is absolutely necessary when 
using the Revize Dreamweaver extension because it is used to specify a root or 
base location in the file system for Revize documents (Templates and Edit 
Pages).  A base location is required to properly reference images and hyperlinks.
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5.1.2 Revize Enable Step 2:  
Creating an Idetix webSpace 

You can create a webSpace through the Revize Admin Center or 
through the Dreamweaver Extension.  When using the Dreamweaver 
Extension to create a webSpace a Revize output Channel is 
automatically defined at the same time. 

Channels

You can publish and edit Revize pages both on your localhost and/or 
any remote server where Revize is installed.  The Channel feature of 
Revize further enables you to publish to servers other than the one on 
which Revize is installed (refer to Developer Guide ).

webSpace

Revize sets up a webSpace for each web site (or group of web pages) 
being managed by Revize (larger, more complex web sites may 
require more than one webSpace).  A webSpace is not really a space 
strictly speaking (i.e. not a block of free disk space), but rather a 
discrete set of Revize Resources assigned to a given web site 
managed by Revize.  The webSpace simply serves to keep different 
web sites’ Resources (Channels, Modules, Templates, Reference 
Files, and Security) separate from all other web sites edited by the 
same copy of Revize.

Creating webSpace and Channel from Dreamweaver 

1. Revize Enabling Step 2: 
From the Revize menu click CREATE IDETIX WEBSPACE
The following screen will appear: 
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Figure: WebSpace Setup 

The webSpace name will default to the name of the base directory 
(tutorial) and the location will default to the directory you just specified 
when you created the Dreamweaver site. 

5.1.3 Revize Enable Step 3:  
Open the Tutorial Home Page

Whether you are just Revize-enabling an existing web site or you are 
designing a new Revize web site from scratch, the first thing to decide 
is what items on a page or pages you want the Editor to be able to 
change.  For this lesson we are assuming you have already designed 
the page and are ready to make different items editable. 

Begin working with the tutorial home page (index.html). 

2. Revize Enabling Step 3:
From the Dreamweaver site window double click on index.html .

The areas of the index page we will make editable are indicated in 
the figure on the next page:
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Figure: Index.html Page

5.1.4 Revize Enable Step 4: Revize Enable Document 

From the top Dreamweaver Menu, click the REVIZE menu, and select 
REVIZE ENABLE DOCUMENT.  When the Revize Enable screen appears 
make sure that all the fields are filled out as follows. 

Document Type = Unique Template

webSpace = tutorial

Template Name = index

Path/Filename = index.html

Click OK.
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Figure: Document Window (Revize Enable Document)

You are creating a Unique Template because this page does not 
depend on information on another page to exist. Make sure to verify 
the default information.

You will have now created a Revize Template named index.rzt in the 
local file system.  Your original page layout is saved as index-
beforerevize.  The original index.html page still exists, but as soon as 
the Revize publishing engine is triggered, it will be overwritten.  Return 
to the Dreamweaver site menu and you will see these new files.

5.1.5 Revize Enable Step 5: Define Revize Modules 

Modules & Field Names 

A Module is a set of field names (and associated content contained in 
Records) for a specific page or a set of pages for a particular area of a 
web site.  For example, a contact page for a web site would have a 
Module name like “contact_us”.

DEVELOPER’S Note:  Underscores are used for spaces.  Revize does not allow 
you to use spaces in either Modules or field names.
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 For example, the contact page may contain the fields name, address, 
city, directions, office_image, or any other fields that pertain to the web 
page Contact Us.  This is usually how Modules are used, but you can 
use them in other ways as well.

Fields & Field Types 

Fields are the names of areas that are editable on a specific web page 
or section.  Field Types are field definitions.  There are seven types of 
field types currently used by Revize.

�� Text

�� Long Text (allows longer text inside record) 

�� Image

�� Number

�� Date

�� Decimal

�� Reference File 

The Text field type is for text that you want to change.  This is the most 
widely used field type.  The Long Text field type is a variation of the 
text field type but it allows more text to be inserted. The Image field 
type is used for images that you want to make changeable. Reference 
File is for referencing an uploaded file that you want linked to a certain 
area of a page.  Word docs, pdf files, or any other type of file can be 
uploaded and referenced by this field type.  All of this will become 
clearer as you work through the examples in the rest of this tutorial. 

Now that you understand what makes up a module, let’s create the 
home module, an easy task.

Use the following Module and field names for the index page. 
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    Module Name: home

    

         DEVELOPER’S SUGGESTION: always use lowercase for module names and use 
name that are easy to remember or relevant to the information that is being edited.
This avoids remembering naming conventions that often vary between people.

Continue Revize Enabling Step 5:
First, go to Create Modules and / or Fields, from the Revize Menu.

In the Module Name area:

Add:
Module name = home

Then move down to the field information area and add the 
following fields:

Field Names�Æ Type

mission_text Text 

tip Text 

home_image Image 

DEVELOPER’S NOTE: Revize does not allow spaces in field names so use _ 
(underscore) for spaces.
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Name= mission_text
Field Type = Text

Select: ADD FIELD 

Name= tip
Field Type=text

Select: ADD FIELD 

Name=image
Field Type=image

Select ADD FIELD 

Click OK on the Module Properties Screen 

This is how your Create Modules and/or Field Menu should look 

Figure: Revize Module Window



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 34

5.1.6  Revize Enable Step 6: Place Revize Objects on Page 

From the Object window  located in Dreamweaver, select the revize 
menu from the tab selection. You should then see the Revize objects 
on the screen.

Figure: Object Window

1. Using your mouse, select one of the pieces of text you want to 
make editable. For this exercise, select the text shown in the figure 
below.

Figure: Selection for editable text

�b�b�b�b DEVELOPER’S CHECK:  Make sure the Dreamweaver Objects window is open (use 
window menu to open).



Dreamweaver Tutorial 

�¤ 2001-2002 Idetix Software Systems Page 35

Developer Tip : Do not select all the text at once (as shown 
above), as you may lose the formatting. 

Continue Revize Enabling Step 6:
Once the text is selected, click on the RZ TEXT object button in the 
objects window, indicated by: 

A dialog window for the Revize Text Object window then displays 

Figure: Revize Text Window 

Select:

Module  = home .  The fields for this Module are displayed.

field name  = mission_text.

Click OK.
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Delete the extra text that you did not select to retain formatting 

CAUTION: It is a good idea to store your template, and view the published page in the 
browser before proceeding. To do this click Revize> Store Updated Template. Then go 
to the page’s URL in your browser. Testing the page after adding the first Revize field 
will help to catch setup and configuration problems at an early stage, saving a lot of time 
in the long run. 

2. Repeat steps the steps that you went trough to enable the “Mission 
Text” for the tip of day area of the page. Be sure to delete the 
quotes before  enabling as leaving them will make Revize think 
that its part of a jsp tag and generate an error. 

5.1.7 Setting Up Editable Images 

To define the editable images in Dreamweaver, you will need to use 
the RZ Image object on the objects palette 

3. First, Select  the truck image on the homepage.

Figure: Hightlighed Image 

DEVELOPER’S NOTE: Dreamweaver may warn you that the element 
will not be visible unless Invisible Elements are checked.  These 
settings are not used for displaying Revize objects, so this prompt 
can be ignored. 
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Once the image is highlighted (Figure: Highlighted Image) 

Select Rz.Image from your Object Selection Menu, see Figure: Object
Window

click on the REVIZE IMAGE button .

When the Revize Image window appears it will give you several 
options (see figure:Revize Image Screen, Below)

Select:
Module fields:
Type = home
Field Type = home_image

Figure: Revize Image Screen 
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Select : Yes, Display the Template – Editable on Form (default). 

Click OK.

The truck image on the page has now changed to a Revize image 
placeholder indicating the Module and field name containing the image 
URL, See figure: RZ.Image placeholder below, which is below.

Figure: Rz.Image Placeholder

Revize Enabling Step 7 Store Updated Template
From the Revize menu, select STORE UPDATED TEMPLATE . This will 
store your changes in Revize. 

Revize Enabling Step 8:  Return to your browser 
http://localhost:8080/revize/tutorial/index.html and click, REFRESH or
RELOAD .

You will notice the image no longer appears.  This is because the URL 
of a blank image is initially stored in the content database.  You can 
upload a new image after you create the Custom Edit Page in the next 
lesson.

You are now ready to add edit buttons to the Template and then move 
to creating the Edit Page. 

DEVELOPER’S NOTE:  Don’t worry about getting the image URL into the 
Module field – you will see how this is done automatically later in the tutorial.
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5.1.8 Adding Control Buttons 

The last thing to do to the Template is to place a FORWARD TO EDIT
FORM button on the Template so when the Editor clicks on the button, 
an Edit Form page appears.

To Place the “F ORWARD TO” button On The Page Do The 
Following:

Go to the Revize Object Menu, Select “RZ button” on the menu, when 
the Revize Button Menu appears: 

Under “What happens when button is clicked?”  Select: 
Other Action = Edit This Page,

Under “How should the button be displayed?”  Select: 
Standard Revize Image = Edit This Page

Click OK.

Your filled in REVIZE button  window should look like the figure below:
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Figure: Revize Button Menu

You now should have the home page completely Revize Enabled. The 
Global Information on the home page will be covered in a future 
lesson.  Your page should look like the one in Figure: completed index.html 
page. If it does, then you are ready to create an Edit Page to edit 
content for this page. If it does not, please go back and see what you 
may have done wrong. 

DEVELOPER’S NOTE: After you have clicked on the object, a Revize window 
displays.  The default selections are context sensitive based on the type of Revize 
document you are currently working on. 

1. Notice and verify the following default selections are as shown above. 

2. After verifying the options, click OK.
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Figure: completed index.html page 

Revize Enable Step 7: Re-Store Your Updated Templat e 
Store Revize template 

Because you made changes to the template when you added the “edit 
this page” button. You will need to re-store your template to the Revize 
database.

Store the completed home page Template by selecting STORE
UPDATED TEMPLATE from the Revize menu.

Revize Enable Step 8: View Published page in browse r

Return to your browser and verify that the home page published 
correctly.

Developer’s Tip : The value of checking your work as you go cannot be 
overstated.  You will be using this page as a base for the next page you 
create, so having it correct at this stage saves time in the long run.  Besides, 
you probably want to see that Revize is doing what you expect.
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5.1.9  Revize Enable Step 9: Create Associated Edit  Forms  

Now that you have created a Revize Template for the homepage, you 
are now ready to create a Custom Edit Page that allows an Editor to 
enter content (i.e. text and images) using a standard web browser.

Steps in creating Custom Edit Form: 

Follow the steps below to create the Custom Edit Page. 

1. Revize Enabling Step 3:
Start with the Revize Template you just created (open index.rzt if 
necessary).

2. Revize Enabling Step 4:
Click on REVIZE in the main Dreamweaver menu then select 
REVIZE ENABLE DOCUMENT.

3. When the REVIZE ENABLE window displays,
Select:
Document Type = EDIT FORM

Leave the Login URL blank. 

IMPORTANT DEVELOPER’S NOTE :  If the page you are transforming into an Edit 
Form already contains a non-Revize form of any sort, Dreamweaver will not render 
the Edit Form page correctly.  If you are not familiar with HTML, you will need help 
from Technical Support to correct this problem.  If you are familiar with HTML, the 
process for correcting this problem is fairly simple.  You simply need to delete the 
existing form tags and submit button, so the Revize form objects will work correctly. 

DEVELOPER’S NOTE:

  The screen changes to display properties applicable to this type of document.

  The Path/Filename defaults to index-editform.jsp   (the same URL as the 
forward to button on your Template).
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4. For Edit Module , select home  (the Module containing home page 
content).  At this point, this is probably the only Module you have 
defined.

If your screen looks like Figure: Document Window (Edit Form) that is 
below, click OK.  If not, review the steps above. 

Figure: Document Window (Edit Form)

5. The following prompt will then appear.  This simply asks you if you 
want to make a edit page based on the template you are working 
on. This is correct, so click OK again.

Notice the document has been saved as index-editform.jsp  (the 
Template index.rzt  is unaffected). 
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You should now see a red line around your entire page indicating 
everything is inside an Edit Form.  If the page already contains a form, 
the Edit Form will not be added.  You will need to go back to the 
template, and take out the <form> tags and submit buttons in order for 
the Revize form to work.

You are now ready to modify the Revize objects on the page and turn 
them into form objects for an Edit Page.

6. Select a Revize object. Your properties inspector will change to a 
Revize inspector like the one shown in, Figure: Revize Properties menu.
If the property inspector window is not open, select WINDOW >
PROPERTIES from the Dreamweaver menu.  Once the window is 
open, you may need to click on the arrow in the lower right corner 
to fully enlarge the properties inspector window. 

Figure: Revize Properties menu 

7. Select either EDITABLE SINGLE-LINE or EDITABLE MULTI-LINE
depending on what type of editable area you want for each field. 
You can then specify additional field properties such as size or 
number of characters and number of lines if you want to use a 
multi-line form field.

You may want to add a caption in front of each Edit field for more 
clarity.

Developer’s Note: The left boxes reference the Module and field names.
Clicking on the question mark in the upper right corner displays a help screen 
explaining all the options in more detail.
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8. Repeat this step for the rest of the editable TEXT objects on the 
page.

Developer Tip : Be somewhat patient when you are making changes to the 
Revize objects within Dreamweaver, as the program is in continuous 
communication with the local web application server to reflect the changes 
you make.

5.1.10 Making the Image on the Edit Page Editable  

The process of Revize enabling an image object is a bit different from 
the editing process for text objects because Revize Images CANNOT 
be changed with the property inspector.

9. First, select the existing image object by clicking on it.  The image 
object is represented with a big red X.

10. Revize Enabling Step 6:
Next, click on the REVIZE IMAGE object button on the Revize 
Dreamweaver object window. 

Figure: Revize Image Object

Developer’s Note:  the text fields don’t appear because they cannot be 
displayed as images. 

Developer’s Note: The Revize enabled image that is displayed in front of you 
on your edit form should display a “change_image” button inside. If it does not, 
then follow the steps below. If it does then it has changed automatically to an 
editable image object and therefore needs no further involvement by you to 
allow the editor to make changes to the page. 

The instructions below walk you though re-revize enabling an image on the 
edit-form if it is needed. 
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Figure: Revize Image Object 

The Image Location  is enabled at the bottom of the screen. Use this 
area to group images into a specific image folder or leave blank to 
place images in a common image folder.  Similar images can share 
folders. . Leave this folder blank for this tutorial image.

Developer’s Note:  You have the choice to locate the CHANGE IMAGE button on 
top of the image or to the right of the image. 

Developer’s Note:  This “common image” folder is created by Revize when a 
publish has been made, and images, or other “reference files” have been 
uploaded into the Revize database. It should not to be confused with your own 
“images” folder  . 
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Click OK.

You should now see that the image object has a CHANGE IMAGE button 
displayed (if it didn’t before).

5.1.11 Action Buttons: Save & Cancel 

This page will need a Save button to save the updated content and a 
Cancel button to return to the prior page without saving any changes. 

Follow the instructions below to add the save and cancel buttons to 
your edit page. 

1. Delete the EDIT THIS PAGE button, as it will not be needed on the 
Edit Page. 

Adding the Edit Form Action buttons: 

Place the cursor where you want the SAVE button to appear.  We 
suggest the top of the page so it is visible without scrolling if the page 
is large. 

2. Revize Enabling Step 6: Adding Revize Objects
Select the RZ_BUTTON from the Revize Object window, a screen 
with button formatting information displays. 
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Figure: Revize Button Screen 

Developer Tip : Leaving the Next URL  blank automatically returns 
to the calling page after the updated content is saved.  You can 
specify any other URL if desired. 

You now need to place a CANCEL  button next to the SAVE button.  The 
cursor should be positioned just to the right of the SAVE button just 
added.

Repeat the same steps for the CANCEL as button as did for the SAVE
button.

Developer’s Note: The default selections are context sensitive based on the type 
of document you are creating.  Click OK to accept the default options and place a 
SAVE button on the page.
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5.1.12 Testing your Edit Page 

Your Edit Form page should now look like the figure below. If your Edit 
Form does not look like the one in, Figure: index-editform.jsp Page, you will 
need to go over the steps again to see what you may have missed.

 Figure: index-editform.jsp Page

Before moving on to the next lesson, check to see that this page works 
properly.

3. Revize Enabling Step 8:
Point your browser to: http://localhost:8080/revize/tutorial
Your homepage should display.

4. Log in as a content editor by clicking on the “Demo Site Login ”
image at the top of the page.  If security is enabled (which it is by 
default), you must enter the username root  and password revize
to log in. 
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The “Demo Site Login” graphic is linked to the Revize security area, to 
make it easy to login. When you Revize-enable your own site, you will 
need to include a similar link on your template to allow editors to login 
to the page. Or you could have a separate login page if one on each 
template is not desired.

To link to the Revize security area, create a standard html link to”: 

<a href = ”/revize/security/ ” >

This link will enable content editors to login.  It may be attached to an 
image, a text link, etc., and it may be obvious or concealed. 

Lets continue testing our first Revize enabled page … 

1. Click on the EDIT THIS PAGE button where you placed it on the 
template. Your Edit Page should appear.

2. Change the page text and/or image, then click on the SAVE button.

After the updated content is saved, the home page should reappear.
You may need to REFRESH or RELOAD your home page to see the 
changes.  If they appear, you did everything correctly.
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5.2 SETTING UP GLOBAL INFORMATION & USING POP-UPS

Often, information you post on one page will be duplicated on other 
pages (e.g. company name and info).  To avoid unnecessary repeat 
editing, global information editing allows a single edit operation to 
update universally applicable information on multiple pages 
simultaneously.

In this lesson we will show you how to setup the ability to change the 
demo company’s business hours throughout the site, with just one edit. 
Follow the instructions below to set this up on your tutorial site.

5.2.1 Revize Enable Step 1:Define Dreamweaver Site 

This step has already been completed in previous lesson.

5.2.2 Revize Enable Step 2: Create Idetix webSpace 

This step has already been completed in previous lesson. 

5.2.3 Revize Enable Step 3: Open Page Design (Templ ate) 

Because we just got through enabling the index.html page. Lets use 
that template as it is the only template we currently have. 

5.2.4 Revize Enable Step 4: Revize Enable Template 

This step has already been completed for the template that we are 
working on so there is not need to re-enable. 

5.2.5 Revize Enabling Step 5: Setting Up the Global  
Module

Setting up the Global Module is a similar process to that of creating 
any other Module.

1. Begin by clicking on “Revize>Create Modules and/or Fields .”
Apply the following information: 

Module Name: global

Field Names: mf_hours  and wknd_hours

Field Type: text
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5.2.6 Revize Enabling Step 6: Place Revize Objects on the 
Template

The operation of inserting global fields into Revize Templates is the 
same as that of inserting ordinary text fields as we did in the previous 
lesson.

2. If you don’t have the template open yet, open “index.rzt ” in 
Dreamweaver.

3. Select  the hours that follow “Monday – Friday:” 
at the bottom of the page.

4. Click  on the RZ Text  button on the Revize Objects Menu.
Assign the Module “global” and the field “mf_hours.”

5. Repeat this action for the hours following “Weekend Hours:” 
choosing the “global” Module and the “wknd_hours” field.

5.2.7 Revize Enabling Step 7: Store Updated Templat e 

Because you have made changes to the template by Revize enabling 
more of areas of the page. You need to store the template back into 
the database so Revize can use your current version to create a page.

6. Click Store Updated Template  from the Revize menu. 

5.2.8 Revize Enabling Step 8: View Published Page I n 
Browser

7. Go to your updated page in your web browser to see if the page 
has been update with your new changes. 

Once you have enabled other templates in your tutorial site. You will 
want repeat these steps on all the tutorial templates you have created.
The easiest way to do this is to open each Template, extension .rzt, 
from the Dreamweaver Site window.  If you wish to save time, wait to 
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duplicate this process until it is time to insert global edit buttons on the 
various Template pages. 

5.2.9 Revize Enabling Step 9:  Creating the Global Edit 
Form Page: 

The Edit Form page corresponding to the global information is 
somewhat different in setup from Edit Form pages we have seen up to 
now.  Rather than beginning in “index.rzt” and Revize-enabling it as an 
Edit Form, we will start with a blank Dreamweaver page, insert a table, 
and turn that table into an Edit Form.

1. In a new window, open a blank document in Dreamweaver,  

2.  Insert the table with the parameters shown below:  

Parameters of the table:
 width = 460 pixels 
 height = 200 pixels
 font  = Arial bold
 size = 2 

The top cell’s color is #EEEEEE.

Developer’s Note:  The second and third rows contain two cells.  All these 
parameters may be found in the properties window, and all may be changed to taste 
when you work with your own website.
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Figure: Global Edit Form Table

Once the above table is constructed, it is time to convert it into an Edit 
Form.

3. Click  on “Revize>Revize Enable Document .” (Revize Enabling 
Step 4)
Select:  Edit Form,
Path/Filename = global-editform.jsp“ 
Select  the “global”  Module.

Click OK.

Inserting Edit Form elements .

4. First, click  in the right cell in the second row.

5. Insert a Revize Text field as you normally would on an Edit Form, 
setting:
Module  = “global”
field  =“mf_hours.”

Do the same in the cell immediately below, setting the Module to 
“global” and the field to “wknd_hours. 

6. Now add a Save button and a Cancel button in the bottom row – 
again, as you normally would on an Edit Form.

7. Save your Edit Form page from the File menu. 
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Your tabular Edit Form should now look something like this figure below 

Figure: Completed Global Edit Form

5.2.10  Placing the Global Edit Form Button on the Page: 

Once you have saved your global Edit Form page, return to the 
“index.rzt” page within Dreamweaver.  The Edit Global Information 
button may be placed anywhere on the page.

To create our example:

8. Click  inside the table cell to the right of the Revize enabled hours 
that we setup a few minutes ago.

9. Click  on the RZ Button  icon in the Revize Objects Menu.

Under “What happens when button is clicked? ”

Select:  Edit Global Information under the Other Actions menu. 

Under “How should the button be displayed?”

Select:  The Edit Global Information Revize button under the 
Revize
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The next URL should point to the edit form we just setup in the 
previous pages. In this case though we are going to use a pop us 
edit form to the editor who is editing the hours.

Under the Next URL Check  the Use Popup  box.  To roughly 
match the size of the table on the Edit Form page,

Type in:
popup width = 375
height = 225.

Leave the Scroll pull-down menu on the “no” default.

If the window appears as below in, Figure: Revize Button Menu:,
click OK.

Figure: Revize Button Menu

10. Revize Enabling Step 7: 
Again because we have made more changes to the index.rzt 
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template we need to store in the database again. (Revize Enabling 
Step 7) 

Click  on Revize>Store Updated Template .
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5.3 DEMO SITE NEWS PAGE – LISTS WITH DETAIL PAGES

In Lessons 1 and 2 we showed you some of the basics of Revize 
enabling. In Lesson 1 we demonstrated the process of making different 
pieces of content on a single page editable.  In Lesson 2 we showed 
you how to setup Global Information and use pop-up edit pages to edit 
the that information.

In this Lesson we will create a list of news items on the news.html 
page.

The novel twist from the other pages we enabled is that each listed 
news item will link to a detail page indicating the item’s subject, 
description, and date, as well as pertinent contact information.  As 
discussed in the overview of Dependent Templates, all of these detail 
pages will be served by one single, Dependent Template. 

Do you remember the discussion of Dependent Templates at the 
beginning of this tutorial?  Here is where we learn to implement them 
practically.

We will create the Dependent Template for the detail pages before
creating the Unique Template used for the page containing the list of 
news item titles.  Even before creating the Dependent Template, 
however, we need to set up a Module to hold the editable content for 
the detail pages.  This Module will contain the fields “News,” “Subject,” 
“Description,” “Date,” and “Contact.”  All these fields will be text fields. 
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5.3.1 Revize Enabling Step 1: Setup A Dreamweaver S ite 

This has been completed in lesson 1 and only needs to be done once. 

5.3.2 Revize Enabling Step 2: Create A Revize webSp ace 

This has been done in lesson 1 also and only needs to be done once 

5.3.3 Revize Enable Step 3: Open Template (Page Des ign) 

In this lesson we will be working with the news pages so open 
news_detail.html (to be the dependent template), and news.html (to be 
the unique template)

5.3.4 Revize Enable Step 4: Revize Enable Template 

We will skip this step for now, as we will need to create a module for 
the dependent template to be dependent on.

5.3.5 Revize Enable Step 5: Create Revize Modules 
(Database Tables)

We saw how to create a module in Lesson 1.  For convenience, we will 
repeat the process here for our new module called “news” . This 
module will be used for our press releases.

1. Create the News Module:
From the Revize Objects Menu, select RZ Modules

In the “New Module” area type in: 
Module Name = News
click Add Module.

In the “Field Properties” area add the following fields and types: 
Field Name = subject
Field Type = Text
click Add Field .

Field Name = desc
Field Type = Text
click Add Field .

Field Name = date
Field Type = date
click Add Field .
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Field Name = contact
Field Type = Text
click Add Field .

Field Name = news_file
Field Type = file
click Add Field .

Click OK to add the modules to the Revize database and return to 
Dreamweaver.

The Revize Module screen will appear as shown in, Figure: Create Modules and/or 
Fields below:

Figure: Create Modules and/or Fields
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5.3.6 Revize Enable Step 4: Enable Template 

We are now ready to Revize enable the newsdetail template as a 
dependent template that is dependent upon the “news” module. Open 
the file “newsdetail.html.”

Note that the step of creating a dependent template ideally comes after
the step of creating its corresponding unique template.  Let’s continue 
enabling our template using the instructions below:

1. Click on “Revize>Revize Enable Document .”

Select:

Document Type = Dependent Template
Dependent Module = News 
click OK.

Figure: Revize Enable Document, figure is shown below:

Figure: Revize Enable Document
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5.3.7 Revize Enabling Step 6: Place Revize Objects on the 
Template:

We will now finish setting up the areas of the detail page to display the 
different fields of the module.  Revize-Enable each piece of text (as 
you did on the index template) on the page that will be changeable by 
first selecting the text, then clicking on the Revize Text object in the 
Revize objects Menu, and finally selecting the Module and Field Name 
for the selected piece of text in the Revize Text Window that appears. 
Repeat these steps for each item of changeable text on the page.
(Note:  do not change the file link into a Revize Text object.) 

Next we will enable the file link on the newsdetail template in order to 
allow the editor to upload a “full version” of their news release. Lets 
enable the file link by following the steps below: 

1. First we need to take out the hard-coded link properties that the 
link is currently using, and then replace it with a Revize Link object. 
To do this put your cursor on the link: “XL Line of Distributors 
Released.pdf”. Then go down to the Dreamweaver properties box 
and take out the “distributors.pdf” link property. 

2. Next select the text that was formally the “XL” link and click on the 
RZ File  button in the Revize Object Menu. 

3. In the Revize File window that appears select the news module 
and the news_file field. You can also type in a location in the box 
provided below. This location is where the files will be stored under 
a directory that is created in the website with the same name as 
the webSpace. 

4. Once you have selected the Module, Field, and location (if 
applicable) click OK

5. You should now see a Revize file link on your template. 

6. The last Revize object you need to place on your template is an 
“edit this page”  button in order to allow the editor to edit this 
particular news release from this page. 

7. Click on RZ button , the Revize button window should appear. 
Make sure that under “What happens when button is clicked” that 
“edit this page”  is selected. Under “How should the button be 
displayed” make sure that the “edit this page”  button image will 
be displayed. Click OK
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Now that we have “Revize-Enabled” all the text on the template, and 
we have given the editor a way to get to an edit page. We can store 
the updated template into the Revize database.

5.3.8 Revize Enabling Step 7: Store Updated Templat e 

Click on Revize on the menu bar, then click “Store Updated Template” 
to store the latest version of your template to the database as we did 
with the other templates. 

5.3.9 Revize Enable Step 8: View Published Page In 
Browser

This step won’t be done at this time as the newsdetail template is 
dependent on news releases to exist and we don’t have a way to see 
them or put them in yet. So we will be on to creating an edit page for 
our news releases. 

5.3.10 Revize Enable Step 9: Create Associated Edit  Pages  

IMPORTANT DEVELOPER’S NOTE:   If the page you are transforming into an 
Edit Form already contains a non-Revize form of any sort, Dreamweaver will not 
render the Edit Form page correctly.  If you are not familiar with HTML, you will 
need help from Technical Support to correct this problem.  If you are familiar with 
HTML, the process for correcting this problem is fairly simple.

These are two ways to correct this problem: 

1. Before Revize-enabling your Template into an Edit Form page, but after
saving it as a Template by clicking on “Revize>Store Updated Template ,”
simply delete all non-Revize forms on your page.  They will almost certainly 
not be needed on the Edit Form page.  Or: 

2. After your Template is Revize-enabled to become an Edit Form page (see 
steps below), enter into the code view in Dreamweaver.  At the top of the 
page you will notice an empty form.  Cut and paste the begin and end form 
tags (together with any form-specific tags between them) once in such a way 
that they surround all the areas of your page that contain Revize forms.
Note that if a non-Revize form comes between two Revize forms, the non-
Revize form comes between two Revize forms, the non-Revize form must 
necessarily be deleted from the Edit Page beforehand as per choice a.)
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Because our template newsdetail has all of our fields on it already that 
the editor will be editing and is a better fit then the unique template that 
we will be creating (based on news.html) we will go ahead and create 
an edit form for our news releases now. Following the instructions 
below to complete the edit form. 

1. With newsdetail.rzt  still open, Click on “Revize” in the main 
Dreamweaver menu then select Revize Enable Document

When the Revize Enable window appears, for document type, 
select Edit Form .

You also will need to select a module for your edit form to edit. You 
will see that the news module is already selected because the 
template was dependent on that module. This is the module you 
want to edit, so click OK

If your screen looks like the one in Figure: Revize Enable Document: Edit Form, if not, 
review the steps above. 
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The following prompt will then appear.  Click the OK button again as yes you 
want to use your template as a basis for the edit form.

You should now see a red line around your entire page indicating that 
everything is inside an edit form. 
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5.3.11 Modify your Revize Form Objects Accordingly 

You will notice that again that all your Revize objects that your put on 
the template have turned into form boxes. You may want to change 
some of them to allow editors to put in more then one line of text. You 
can change the width and character height on the form box in the 
Dreamweaver properties box as we did on the index-editform.jsp page. 

5.3.12 Adding Save and Cancel Buttons To The News D etail 
Edit Form 

1. Place the cursor where you want the Save button to appear.  In 
our example we have created a row under our file upload object 
and then put the save and cancel buttons there. You can place 
them wherever you would like though. 

2. Select the RZ_button  from the Revize Object Menu.
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The screen below appears: 

Figure: Revize Button: Save

Developer Tip : leaving the Next URL blank automatically returns to 
the calling page after the updated content is saved.  You can specify 
any other URL if desired. 

You now need to place a “Cancel” button next to the “Save” 
button.  The cursor should be positioned just to the right of the 
Save button just added, so simply click RZ_button .

3. The button window will appear with the same default options (for a 
Save button).  From the “Edit Form Action” drop down menu, 
select: Cancel Update .

Developer’s Note:  that the default selections are context sensitive based on the 
type of document you are creating.  Click the OK button to accept the default 
options and place a save button on the page. 
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You will notice the Standard Revize Image changes to match your 
selection.

Click OK.

4. The last thing we need to do is to remove the button we added to 
the template to forward to this page.  Select the Edit This Page
button by clicking on the icon and then press the Del key. 

5. Save your updated Edit Form page by clicking on the “File” menu 
at the top of the document and clicking on “Save” .

Your Edit Form should now look something like the figure below:

Figure: News Detail Edit Form

If your form looks like the figure above then your are ready to move on 
to enabling the news.html page that will display a list of our news 
releases.
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5.3.13 Revize Enable Step 10: Repeat Steps 3 throug h 9 for 
Each Template 

5.4 REVIZE ENABLING THE NEWS LIST PAGE

5.4.1 Revize Enable Step 3: Open Template (Page Des ign) 

Now that we have created the Dependent Template for the News 
Detail Pages, we are ready to create the Unique Template for the 
News List Page.  Remember, each news item listed on this page will 
link to the appropriate detail page. 

�� Open news.html  in Dreamweaver using the Site window. 

Once again, we will start by turning news.html into a Revize 
Template (this time, a Unique Template).  The steps for creating a 
Unique Template listed in Lesson 1 are repeated here for your 
convenience.

5.4.2 Revize Enabling Step 4: Revize Enable Documen t 

From the top Dreamweaver Menu click on Revize then move down and 
click on the Revize Enable Document menu item.  The following 
screen should appear. 

Figure: Revize Enable Document
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Verify the default information.

webSpace = tutorial
template name = news
path/filename = news.html
channel name = revize

Click OK.

Once you have Revize-Enabled your new Unique Template, delete all 
the rows in the table but one by clicking inside each row, clicking on 
the <tr> tag at the bottom of the screen, and typing the “Del” key.

You may want to take our any unnecessary spacing that the page has 
in it from the other rows you deleted. 

5.4.3 Revize Enabling Step 5: Create Revize Modules  

This step has already been completed for this page, as we will be 
listing out all of the news releases that come from the “news” module 
on this template. 

5.4.4 Revize Enabling Step 6: Place Revize Objects on the 
Template

We will now convert the remaining row into a Revize-enabled list. 
Follow the instructions below to set up the list. 

1. Click inside the remaining row, and then click on the <tr> tag at the 
bottom of the page. (where the HTML tags display) 

2. Next in the Revize object window, click on RZ List .  In the window 
that appears, be sure that the “news” Module is selected to tell 
Revize that you want to list out that module. 

3. Next select the “date” field in the sort area of the window, as we 
will want to have the list sorted by what date the news release was 
added to the page.

4. Click OK.
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You should now see begin list and end list Revize tags above and below the 
row. The row should look something like the figure below: 

Figure: Revize List Tags

The next step is to Revize-Enable the text areas we want used on the 
news list.

5. Continue Revize Enabling Step 6: 
First, Revize-Enable the date by highlighting the text (not all of it, 
to retain formatting), then click on the RZ Text  Object in the 
Objects Menu.  When the Revize Text window appears, click on 
the “news” Module and the “Date” field, and the OK button.

5.4.5 Linking the Subject Text to the Detail Templa te 

It is naturally important for the viewer to be able to link to the proper 
detail page by clicking on a given subject line.  The following shows 
how to link the subject line inside the list of the news page’s Unique 
Template to the detail pages’ Dependent Template. Follow the 
instructions to create a link to the detail page, while displaying the 
news articles’ subject. 

1. Highlight most of the text of the subject line with your mouse.  

2. Click on the RZ Link  button in the Objects Menu. This will bring up 
the Revize link window. Fill in the information as described below: 

Link Name: (Do not type anything here.)

Developer’s Note:  Before proceeding, delete the link assigned to this text from the 
HTML code (if this step is omitted, the Revize Text object will not function properly). 
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Link Target: NOT USED (if you wanted all your links to open in a 
different window you could fill then in) 

Short Form or Long Form: Short Form  (This specifies what 
version of the Revize code do you want to use. Long form will 
show the “href” tag in the Revize code that is put in.) 

Template: The dependent template called “newsdetail” should be 
selected and the news , subject  module and field should be 
selected for what is display.

All other options on the RZ Link window: NOT USED FOR LINK 
MANAGER (Final Chapter)

You RZ Link screen should look like the figure below. If it does click 
OK.
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The result of this process is to link the subject line on the news page 
list to the “newsdetail” Dependent Template. 

5.4.6 Continuing Revize Enabling Step 6: Adding New, 
Edit, and Delete buttons 

Next, we need to add buttons to this template that will allow the editor 
to add new news releases, edit existing ones, and delete unwanted 
ones from the news page. The following steps walk you through adding 
these buttons to your template. 

Adding the “New” Button 

1. Place the cursor in front of the “Begin List” tag on the template 
and click the RZ button  object on the Objects Menu.

2. When the RZ button window appears select “Add New List 
Item”  from the List Item Action drop down list. (Shown under 
What happens when button is clicked?”)

3. Next under “What is displayed…?” make sure that the “New” 
button image is selected 

4. Make sure that “newsdetail-editform.jsp” is shown inside the 
Next URL  area of the window. (Probably displays: news-
editform.jsp right now) 

5. Click OK

Adding the Edit Button 

1. Place your cursor inside the table-row before the date and 
subject of the press release then click on the RZ_button
object in the Dreamweaver objects window.

2. In the window that appears make sure that “Edit this List Item” 
is selected under “What happens when button is clicked?

3. Under “What is displayed…?” make sure that the “Edit” button 
is selected. 
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4. Make sure that “newsdetail-editform.jsp” is shown inside the 
Next URL  area of the window. (Again Probably displays: 
news-editform.jsp right now) 

5. Click OK

Adding the Delete Button

1. Place you cursor next to the “Edit” button and then again click 
on the RZ button object on the Objects Menu.

2. The “Delete this Item” option should be selected under: “What 
happens when button is clicked?”.

3. The “Delete” image should be selected under “What is 
displayed…?”

4. Click OK.

Your news template should now look something like the figure below.

Figure: Completed Template 

5.4.7 Revize Enabling Step 7: Store Updated Templat e 

Now that we have completed enabling our list on this template, and 
added buttons to allow the editor to edit content, we are ready to store 
our template into the Revize database. To do that click on 
“Revize>Store Updated Template  to store the updated template. 
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5.4.8 Revize Enabling Step 8: View Published Page I n 
Browser

You will now want to try adding some news articles to your newly 
enabled news area of the tutorial site. Go to: 

http://localhost:8080/revize/tutorial/news.html to try it out. 

5.4.9 Revize Enabling Step 9: Repeat Steps 3 – 9 for each 
template

Once our news area has been successfully tested, we are ready to 
move onto our next lesson: The Relational Capability: Contacts Area.

Lets do that now…
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5.5 CONTACTS PAGE – USING THE RELATIONAL CAPABILITY

5.5.1 Relational Capability Overview 

This chapter introduces the relational capability.   Expanded use of the 
relational capability allows Content Owners to add new entirely new 
sections to their web site not just new pages to an existing section as 
demonstrated here. 

The next chapter introduces the Link Manager, which combined with 
the relational capability further leverages the reusability of templates.
Web sites or portions of web sites consisting of literally thousands of 
pages can be quite easily created and managed with just a handful of 
templates.

In this chapter we are going to Revize Enable the contacts area of the 
DemositeIII web site using the following templates: 

�� contacts  – displays a list of department names 
(unique template) 

�� contactsbydept  – displays a list of contacts for each department 
(dependent template) 

The contacts page will display a list of departments using the contacts 
template.  Each department will link to a page that displays a list of 
contacts for each department using the contactsbydept template.

A unique template is used to display the list of departments since it is a 
single top-level list that appears on only one page.  However, a 
different list of contacts is displayed for each department. 

Each department list will have the same look and feel but different 
content (e.g Department Name Heading followed by a list of contacts 
for that department).

A single dependent template is used to display each department list of 
contacts.  The department list of contacts is considered “related” to a 
single department 

By utilizing the relational capability we can to store the department 
names in one module (depts) and the contact information for all 
departments in another module (contacts).  Each record in the contacts 
module is “related”  to a record in the depts module and vise versa.
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contacts
template

contactsbydept
template

depts
module

contacts
module

depts.recordid = contacts.dept_id

Using a dept_id field in the contacts module and setting it whenever 
new contact records are added enforces the relationship between 
these two modules and related templates.  Details will be unveiled 
during the Revize enabling process of these templates. 

5.5.2 Revize Enabling the Related Templates 

Even though this area of the web site involves multiple pages based on 
two templates, we still essentially follow the 10-step Revize enabling 
process one template at a time.

The Dreamweaver Site (step 1) and Idetix webSpace (step 2) should 
have already been created when the home page was first Revize 
Enabled.  If not, refer back to that chapter; otherwise let’s get started 
with step 3.



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 78

5.5.3 Revize Enable Step 3: 
Open Template (contacts.html) 

When working with related pages, it is usually easiest to start with the 
top-level page and work your way down the same way a site visitor 
views the pages. 

�� From the Dreamweaver site window open: contacts.html

5.5.4 Revize Enable Step 4: 
Revize Enable Document 

�� From the Revize Menu, Select “Revize Enable” 

�� Use the defaults as shown below: 

5.5.5 Revize Enable Step 5: 
Create Module 

This template only uses a single module.  The contacts module will be 
created while Revize Enabling the contactsbydept template. 

�� From the Dreameaver menu, select:
Revize > Create Modules and/or Fields 

�� Add new Module: depts
New Field Name: dept_name  (type=text) 
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5.5.6 Revize Enable Step 6: 
Placing Object on the Template 

This template will contain a list of links to the contactsbydept
template, which does not yet exist.

As we go through the steps you will see how we can create a 
placeholder contactsbydept  template that can be later replaced.  This 
feature lets us complete one template before moving on to the next. 

1. First we will define a Revize list using the depts  module.  Select all 
the items in the bulleted list.

2. From the Revize object menu, click on:  RZ List 

3. When the dialog window appears select depts  for the List Module 
and Sort by: dept_name  as shown below: 

DEVELOPER’S NOTE: Be sure the bullets and links tags are all selected.
Clicking on any link and then selecting the <ul> tag at the bottom of the
window is probably the easiest.
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4. Use defaults for all other options and click the OK button.

5.  The template should appear as shown below.  The bullets should 
be inside two Revize list tags.  If not press Ctrl-Z and repeat the 
previous step. 

6. Since only one item is needed inside the list, select Human
Resources  and Public Relations  and press the Delete  key.

DEVELOPER’S NOTE: If a second bullet appears as shown below, use the 
backspace or Delete key to remove it. 
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7. Because we want the department name to be a Revize link, 
instead of the current hard-coded link. We need to delete the 
current link properties for in order to Revize enable it.

Remove the current link properties by clicking on Information
Technology  and then in the properties window, highlight the link 
as shown below and press the delete  key.

8. To put in a Revize link for the dept name, highlight most of 
Information Technology  and from the Revize object menu, click 
on: RZ Link.

9. The Link window appears with many options.  Most of these 
options are only applicable to the Link Manager and will be 
covered in that chapter. 

10. Click on the  button in the upper right to create a 
placeholder template for the link. 

11. When the New Template window appears, select the options as 
shown below and click OK. 
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When using links inside an RZ List, the dependent module is always 
the list module. 

12. The new template should now be selected  
For Code Format, select: Short Form 
For the Field, select: dept_name

DEVELOPER’S NOTE: Although this template is going to display content from 
the contacts module, depts  is the Dependent Module. This is because no 
department contact pages can exist unless there is a department record for it.
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13. When everything looks as below, click OK

Your template should now look like the screen below: 

Of course you need to delete the “I”  and “y”  not selected to retain 
formatting.

14. Next we will add Revize Edit Controls: edit , delete  and new
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�� For the edit button, position the cursor between the bullet and 
the Revize link (RZ depts.depts_name) and then from the 
Revize object menu, select: RZ Button

When the button window appears use the following options.
The defaults should be good except for the Popup options 

�� For the delete  button, position the cursor to the right of the edit 
button, click RZ button  and accept the default options. 



Dreamweaver Tutorial 

�¤ 2001-2002 Idetix Software Systems Page 85

�� For the new button, position the cursor after the “Department 
Contacts” heading, but before the Begin List tag, then select 
the RZ button  object, and use the options shown below 
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5.5.7 Revize Enable Step 7: 
Store Revize template 

Your finished template should look like the image below: 

Store the completed template by clicking on
Revize > Store Updated Template

5.5.8 Revize Enable Step 8: 
View Published page in browser

�� From a browser bring up the contacts.html page 

�� Verify the page published correctly 

�� You should see a single bulleted entry as shown below: 

5.5.9 Revize Enable Step 9: 
Create associated Edit Form

1. From the Site View in Dreamweaver Select: File>New File : then 
create the filename contacts-editform.jsp

2. Open (double click): contacts-editform.jsp

Revize Enable the edit page by: 
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3. Clicking on Dreamweaver Menu and selecting: Revize>Revize
Enable Document 

�� Document Type: Edit Form

�� Module: depts

4. Create a table for our edit form fields, by going to the 
Dreamweaver Menu and selecting: Insert > Table

�� 2 Columns 

�� 3 Rows 

�� 400 pixels wide 

�� 200 pixels high 

5. Merge the two cells in the top and the bottom rows so it looks like 
the one displayed below: 

6. In the top row enter heading: Departments Edit Form

7. In next cell on left enter text: Department Name: 

8. In cell to the right, put: RZ Text : depts.dept_name 

9. In bottom row, add buttons: Save & Cancel

10. Save completed form as shown by pressing: CTRL-S

Your completed edit form should look like the figure shown below: 
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You should now be able to return to the browser window and enter 
departments.

5.5.10 Revize Enable Step 10: 
Repeat Steps 3-9 for Next Template 

Now we are ready to repeat the above steps for the contactsbydept
template.  This is where you will learn how to configure the relational 
capability.

Besides learning how to use the Relational Capability, we will learn 
how to use repeating tables inside a list, display names sorted by last 
name, display an email address and display a lookup field from 
another module. 

5.5.11 Revize Enable Step 3: 
Open Template (contactsbydept.html) 

�� From the Dreamweaver site window open: contactsbydept.html

5.5.12 Revize Enable Step 4: Revize Enable Document  

�� From the Revize Menu, Select “Revize Enable Document”

�� Use the defaults as shown below: 
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NOTE: Although this page is going to display content from the 
contacts module, depts  is the Dependent Module.

The dependent module is always the module specified on the link 
that points to this page.  When the RZ link is inside a list, the list 
module becomes the dependent module of the template that is 
linked to. 

5.5.13 Revize Enable Step 5: Create Module 

The relational capability lets us store contact information for all 
departments in the same module.

�� From the Dreamweaver menu, select:
Revize > Create Modules and/or Fields 

�� Create the following module: contacts

Field Name Field Type 
dept_id  number 
name_first  Text 
name_last Text
phone  Text 
email  Text 
title  Text 

To utilize the relational capability, a relationship is established between 
the depts  module and the contacts module.  Whenever a new record 
is added to the contacts module, the dept_id field is “set” to the record 
id from the corresponding department in the depts  module.

No special action is required to enter the dept module record id.
Whenever a record is added to any Revize module, a record Id is 
automatically assigned a new number starting from 0.  The screen 
below shows the records from the “depts” module after 3 departments 
have been added. 
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The charts below show the relationships between the tables after a few 
contacts have been entered: 

depts module 

Id dept_name

0 Human Resources 

1 Information Technology 

2 Public Relations 

contacts module 

Id dept
_id

first_
name

last_
name

phone email title

0 0 Henry  Morris 248-555-0000 henry@abc.com HR 
Manager

1 0 Bonnie  Coats 248-555-0001 bonnie@abc.com Benefits 
Coordinator

2 1 Ivan  Davis 248-555-1002 ivan@abc.com IT 
Director

3 1 Wayne Masters 248-555-1003 wayne@abc.com Web 
Master

4 2 Pam  Stouts 248-555-2004 pam@abc.com Press 
Secretary

5.5.14 Revize Enable Step 6: 
Placing Object on the Template 

This template displays the contact information for all department 
contacts.
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5.5.15 RZ List Object 

Note that each discrete set of contact data is formatted as a separate 
table.

1. Highlight the entire first table.   

Note: This is easiest done by clicking anywhere inside the table 
and selecting the <table> tag at the bottom of the window as 
shown above. 

2. From the object menu, select: RZ List

3. Select the options shown below: 

�� List Module: contacts

�� Sort: name_last   name_first 

�� Filter List By: contacts.dept_id = depts._recordid
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Any field can be used for filter (i.e. relationship) however, id fields are 
preferred because text fields could change and break the relationship. 

4. When all options are properly select, Click on OK

First select name_last, 
then select name_first, 
then click on move_down 

Sort is based on the order 
fields are listed 

Relationship
defined here 



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 94

5. Next delete the remaining tables - leaving only the table that has 
become a Revize List. 

5.5.16 RZ Text Objects 

6. First highlight Department  (in the page heading)
and from object menu select: RZ Text

�� When the text screen appears, select: 
Module: depts
Field: dept_name

7. Next highlight the first name: Ivan
and select: RZ Text

�� When the RZ text screen appears, select 
Module: contacts
Field: name_first

8. Next select “Davis ” and use RZ Text for: name_last

9. Use the following procedure to insert an email link 

�� In the html view position the cursor at the beginning of the cell 
in front of the email address as shown below: 

�� From the object menu, select: RZ Text

�� Select the following options when the Text window appears: 
Is TEXT Content Changed on this page? : No Display Only
Module: contacts
Field: email
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Note:  The “No Display Only”  option will insert the long form 
of version of Revize code that can be manipulated as 
described below to accommodate an email link. 

�� In the HTML code view, highlight: <%=rz.content%>  then Cut

�� Paste into both occurrences of ivan@abc.com  as below.

�� Notice there is no longer any code between the <rz:fetch…> 
and the </rz.fetch> tags.  Nothing will display for this tag 

10. Use RZ Text  object in the normal manner for the phone  and title
text areas of the contact information table 

11. You can replace the table at the bottom of the page containing 
business hours with a table from an earlier Revize Enabled 
template. (See Revize Enabling Global Areas)
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5.5.17 RZ Button Objects 

Since this page contains a Revize list, we need New, Edit  and Delete
RZ buttons.  Follow the steps below to add these buttons.

Note:  Care MUST be taken when adding the New button.  This is an 
essential step to properly utilize the Relational Capability .

1. To add the New button, position the cursor in front of the RZ List 
object and select: RZ button from the Revize Objects Menu 

When the button window opens, select the following options: 
List Item Action: Add a New List Item
Effected Module: contacts
Use Popup: Not Checked
Related List Properties: contacts.dept_id = depts._recordid 

IT IS ABSOLUTELY IMPERATIVE  to define the Related List 
properties.  They will not appear until the Effected Module is 
defined.  If these properties are not correctly defined, this page will 
NOT display the correct information because new records added 
to the “contacts”  module will not be connected to the 
corresponding “depts”  module as was described previously. 
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Note: In more advanced usage of the Relational Capability 
(usually when more the two (2) modules are related), it may be 
necessary to set more than one field when adding a new record.
The “Add Above Setting”  is used to set the one field and then set 
another.

The Related List property settings are passed to the associated 
edit form as URL arguments. 
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2. To add the Edit  button, position the cursor at the end of the 
Horizontal Rule inside the contacts table and select: RZ button

When the button window opens, select the following options: 
List Item Action: Edit a List Item
Use Popup: Not Checked

There is never any harm in defining the Related List properties for 
an edit button (they are only used when a new record is created).
When in doubt, define the Related List properties.  However 
remember, the Effected Module must be selected in order to define 
these properties. 

3. To add the Delete  button, position the cursor after the Edit Button 
select: RZ button

When the button window opens, select the following options: 
List Item Action: Delete a List Item
Accept remaining default values. 

DEVELOPER’S Note:  No special action is required on the edit button to utilize the 
Relational Capability when there is an associated new button and content is 
displayed in a list. (The Revize list already contains a filter)   When there is not 
an associated new button and only a single record is displayed, the edit button can 
effectively act as a new button and the Related List properties MUST be defined.
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5.5.18 Revize Enable Step 7:Store Revize template 

�� Your finished template should look like the image below: 

�� Store the completed template by clicking on Menu: 
Revize > Store Updated Template

�� Note:  because we previously created a placeholder template, you 
will see a warning message similar to the one shown below: 

�� This message is shown because that the placeholder template you 
created earlier is newer the real one you are storing now. 

�� Go ahead and click: OK
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�� Because you linked to the placeholder version of your template on 
the contacts template, you will also need to restore this template in 
order to tell have Revize update its relationship between the two 
templates.

5.5.19 Revize Enable Step 8: View Published page in  
browser

�� From your browser bring up: contacts.html  under your tutorial site 

�� Click on a the first department 

�� You should see placeholder content (This is a standard text 
field…)

5.5.20 Revize Enable Step 9: 
Create associated Edit Form

Our completed template can easily be converted into an edit form for 
use by the content editor. Lets do that now. 

1. If necessary, open: contactsbydept.rzt

2. From the menu, select: Revize > Convert Document Type

�� When the Document Window opens select the following 
options:
Document Type: Edit Form
Path / Filename: contactsbydept-editform.jsp  (default) 
Edit Module: contacts
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�� Note: The depts  is the Dependent Module for the template 
because the dependent module is always the same as the 
linked from or list module.  However, the edit form will of 
course be updating the contacts  module. 

�� Click OK after selecting options and OK again when told the 
template will be converted to an edit form.

3. Remove the RZ List as follows: 

�� Highlight and Delete: RZ // begin list \\

�� Highlight and Delete: RZ \\ end list //

4. Replace  buttons as follows 

�� Highlight and Delete: New button 

�� Add buttons: Save and Cancel (default options) 

�� Delete row containing: Edit  and Delete  buttons 

5. Update  RZ Text Objects as follows: 

�� Select the entire Name row 

�� Copy with CTRL-C or from menu: Edit > Copy



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 102

�� Position cursor anywhere inside the Name row 

�� Paste with CTRL-V or from menu: Edit > Paste

�� Select from menu: Revize > Refresh Display

�� In top row, change label to: First Name
Delete RZ contacts.name_last

�� In next row, change label to: Last Name
Delete RZ contacts.name_first

�� In email row,

o Delete:

o Select: RZ contacts.email

o Open properties window if necessary 
(menu: Windows > Properties) 

o In properties window,
change type: Editable, Single Line

6. Save Completed Edit Form 

�� Press CTRL-S or from menu, select: File > Save File

7. Return to Browser and Enter Content 

�� Enter URL: contacts.html

�� On contacts page, click: edit  (assuming you are logged in) 

�� Update the selected department name

DEVELOPER’S Note:  None of these fields have where attributes but they must be 
removed from any fields used on edit forms used to input content.  For example:

change:

      <rz:fetch  module="jobtitle " field="title" output="html"
        where=”jobtitle._recordid=contacts.jobtitle_id”
        options="size=30,wrap=Virtual"/>

to:

      <rz:fetch  module="jobtitle " field="title" output="html"
        options="size=30,wrap=Virtual"/>
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�� Click on the updated department name and add some contacts 

�� Upon return to contacts.html, click: new

�� Enter a new department name 

�� Click on the new department and add some contacts 

�� If something is awry, review these steps for possible errors 

Note:  You need to have at least 2 different departments with contacts 
in them to make sure that everything is working correctly. 

5.5.21 Revize Enable Step 10: 
 repeat steps 3 through 9

Repeat the above steps for each page design. 

The next few lessons in the tutorial will show you how to make the 
other types of pages you will need on your site, but you will always 
follow the same general guidelines as you do each one. 

5.6 ENABLING THE ALLCONTACTSBYDEPT TEMPLATE

Before we move on to the products area of our tutorial site, which will 
cover our “Link Manger” feature. We have one final template to enable 
in our contacts area. This template will list all contacts on one page 
and group them by their respective departments. 

This feature in Revize is called “Group By” it is part of the RZ List
object in Revize. See the figure below for reference. 
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Figure: RZ List Object w/ group by selected:

We will enable this page as we have all the others in our tutorial by 
following the 10 steps of Revize enabling. Steps 1 and 2 have already 
been done in lesson 1 so we can start with Step 3: Open Template 
(Page Design).

5.6.1 Revize Enabling Step 3: Open Template (Page 
Design)

Open the page allcontactsbydept.html in Dreamweaver. 
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5.6.2 Revize Enabling Step 4: Revize Enable Documen t 

Revize enable the allcontactsbydept.html into a Revize template as we 
did on other templates by clicking Revize>Revize Enable Document 

This template will be a unique as it is also a stand-alone page that is 
not dependent upon content in a module to exist. We will use the 
default options that are displayed in the Revize Document window they 
are:

Template Type: Unique

Template Name: allcontactsbydept

Path/Filename: allcontactsbydept.html

Channel: Revize

Click OK

5.6.3 Revize Enable Step 5: Create Revize Modules 

We will use the same modules for this page as we did for the others in 
the contacts area depts, and contacts. 

5.6.4 Revize Enable Step 6: Place Revize Objects on  the 
Page

As you already know this is the longest step in the Revize Enabling 
process. This page is a little tricky as we will be using the code view 
some of the time. Follow the steps below to enable the list of contacts 
on the page and group them by department. 

1.  The first thing we want to do is put a Revize list on our template 
telling Revize to list out the contacts module records, sort them all 
by deptid, and then group them by deptid. 

To do this we first need to select on the page what we want to 
repeat. In this case we want to repeat the contact information table 
and the department header table. However the department header 
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table will only be created when a new contact is added to a 
department that is different then the ones already on the page. 
Lets put our list tag in now. 

Select both the first department header table and the first contact 
information table as shown in the figure below: 

Next click on the RZ List object on the Revize Objects Menu. Be 
sure to select the settings below: 

List Module: Contacts
Sort By: deptid
Group By: deptid

Click OK

Your RZ List screen should look like the one below: 
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Figure: RZ List Group By:

3. You should now have your RZ List tags on the template. There 
should a “// Begin List “ above your department header table and 
an “// End List” after your contact information table. 

4. If you have put the list on the template. Delete all other department 
header and contact information tables on the page. 

5. Next to your “//Begin List” and you “// End List” tags your will also 
see some hidden code tags that are marked “ASP”. These are 
“group by” tags that Revize put in that we will modify in the html in 
order to have Revize display our department header table only 
when needed. 

Click on the “// Begin List” Revize tag on your template and click 
on the code view in Dreamweaver you should see the following: 



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 108

You will notice that Revize has put in 2 sets of grouping tags as shown 
in the figure above. One is for a group header (shown above) and the 
other is for the group footer (placed before the end list tag). 

We need to move our department header table code from where it is 
and place it in between the group header tags telling Revize to display 
that table for each group. Cut and paste your department header table 
code so it looks like the figure below: 
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Once you have done this you can now go back to the design view. 
Your template should now look like the figure below: 

6. Now that you have your Revize list on your template and you have 
setup the group by tags to display the department header table for 
each department name, you are ready to Revize enable the text as 
usual.

Revize enable the Name, Phone, and Title areas of the contact 
information table as you did before. Then Revize enable the email 
area as well using our little code trick from the previous lesson as 
well.

Your template should now look like the figure below: 



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 110

7. Now that we have enabled all of our contact information we are 
ready to enable the department name inside our group header 
table. The trick here is that in order to only show the correct 
department name for the contacts shown below the header we 
have to filter the department name by the deptid of contacts shown 
below the name. This is easily done through the RZ Text object.

Highlight most of the “Human Resources” department name and 
click on RZ Text. Select the following options as shown in the 
figure below in order to display the correct department name for 
contact.  Note:  The bottom box may only show up when you click 
on the corresponding check box.
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You will notice that we filtered the department name by the exact 
opposite filter we put on our contactsbydept template. This tells 
Revize to only display the department name when the departments 
recordid is equal to the contacts deptid of the contacts shown 
below it.

8. Your template should look like the figure below. If it does you are 
ready to store the template into the Revize database and see if it 
works.

5.6.5 Revize Enable Step 7: Store Updated Template 

Store your allcontactsbydept template by clicking Revize>Store
Updated Template 

5.6.6 Revize Enable Step 8: View Published Page In 
Browser

Go to your allcontactsbydept.html page in your browser by first going 
to your contacts.html page and then clicking the “See All Contacts”. 
You should see all of the contacts that you have entered and they 
should be separated by department. If not you will want to check your 
work. The most popular problem is messing up the filter on the 
department name. 
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5.6.7 Revize Enable Step 9: Create Associated Edit Forms 

This was already completed in the previous lesson, however you may 
want to add edit and delete buttons to this page if you want editors to 
be able to edit from the allcontactsbydept page, but this is optional. 

5.6.8 Revize Enable Step 10: Repeat Steps 3 thru 9 for 
Each Template 

We will now move on to our link manager lessons. Using the Revize 
enabling steps to enable your pages keeps you aware of where you 
are at in the process. It’s a good idea to have a list of them handy. 

Lets move on to the next lesson.
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6 USING LINK MANAGER 

6.1 PRODUCTS TEMPLATE – WORKING WITH A FREE FORM

TEMPLATE

6.2 OPEN PRODUCTS.HTML (REVIZE ENABLE STEP #3)

6.2.1 Revize Enabling products.html (Revize Enable Step 
#4)

6. With the products.html  open, click the REVIZE menu, and 
select REVIZE ENABLE DOCUMENT.  When the Revize Enable 
screen appears make sure that all the fields are filled out as 
follows.

Document Type = Unique Template

webSpace = tutorial

Template Name = products

Path/Filename = products.html

Click OK.
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Revize Enable Step 5: Create Module: Setup For A Module: product_home 

7. First, go to Create Modules and / or Fields , from the Revize 
Menu.

Create a Module called products_home , include the field 
name text  and the type to be Long Text . See the example 
below.
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6.2.2 Creating a Free Form Template 

We will now create a template known as a Free Form Template, 
which will allow the Content Editor the ability to add images and 
control the text through the text editor. 

8. Select the text inside of the paragraph. 

9. Click the Rz.Text button located in the toolbar. 

10. Remove all other text in table that is not needed. 
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Template Should Look Something Like the Figure Below 

Add An Edit this Page Button (Revize Enable Step 6) 

11. Position the cursor in the table cell above the 
product_home.text, click on RZ button  in the Revize object 
window.  A button formatting screen displays. 

Make sure that when the Revize button window displays that it is 
creating an edit this page  button in the “Other  Action” area, and 
that the Next URL says that it is going to open  the products-
editform.jsp editform, as we will create this form in a moment. 

Free Form gives you the freedom to add less in the process of 
setting up a Revize template, and more control for the Editor to add 
what they want to the page.
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12. Store Updated Template . (Revize Enabling Step 7) 

6.2.3 Create an Edit Form For The Products Page  
(Revize Enabling Step 9) 

13. With the products.rzt  open, click the REVIZE menu, and 
select REVIZE ENABLE DOCUMENT.  When the Revize Enable 
screen appears, select Document type: Editform. Select the 
products module and click OK to continue.

14. You will now be asked if you want to convert your template into 
an edit form page. Click the OK button (see window below).
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15. You will notice now that the products_home.text you had 
applied to the .rzt has now changed into a form text area. We 
want the editor to have more options then just plain text so we 
will use the Revize text editor here. To put the text editor in, 
select the textbox, and then click the Revize Editor button from 
the objects window. The Revize Editor window will now 
appear.

In The Text Editor Screen Select:

Module = products_home
Field = text

Select the button = Set All
This will give all rights to the Editor to add text and 
images to this page. 

Note: The check  boxes that are under the Editor Options 
allow for you to choose what control you would like the 
editor to have.
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Click OK.

16. Add some text above the editor to tell the editor what they are 
editing:
Type: Products Page Content
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6.2.4 Delete Unused Buttons & Add Save and Cancel 
Buttons

17. Delete the “Edit This Page” button that you had put in on your 
template. Next, position the cursor in the table cell to contain 
the buttons and click on RZ button  in the Revize object 
window.  A button-formatting screen displays. Make sure that 
the “Save Changes “ button is selected and that you want to 
display that button graphic, and then click “OK”. Repeat this 
operation for the cancel button. Your edit form should look like 
the figure below. 

18. Save the newly created Editform. (File> Save)

19. Try out your new editable products.html page by going to:

http://localhost:8080/revize/tutorial/products.html

If you were successful in editing your products.html page with the text 
editor then you are ready to move on to adding the ability to add pages 
to your tutorial site using Revize’s Link Manager component. 
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6.3 PRODUCTS TEMPLATE – WORKING WITH LINK MANAGER

A little information about the Revize’s link manager component:

Revize’s link manager component allows the editor to add links to 
pages based on pre-defined templates that the developer has setup for 
them, while also allowing them to create other kinds of links including: 

�� Links to Outside URL’s 

�� Links to uploaded files or images 

Revize does this in easy to use manner by including a pre-setup 
editform for links in a Revize installation. This pre-setup editform also 
helps the developer in that they don’t have to setup this editform and 
only have to call it by using a “link name” when enabling their 
templates.

In the next few pages you will learn how to setup the link manager 
component similar to what is shown in our demo site. At the end of this 
lesson you should be able to add pages or simple links using the link 
manager component in the products section of our tutorial site. 

Let’s begin:

1.  If it is not currently open, Reopen products.rzt (Revize enable 
step 3)

6.3.1 Revize Enable Step 5: Setup a Module For Our Link 
Manager Links Called: links 
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20. Click on the Revize menu, and select Create Modules and / 
or Fields.  Create a module called links.

Instead of entering each field name in for the module links , we will 
click the add Link Manager Fields button to add all the necessary 
field names for a pre-completed link manager edit form. These 
distinct field names are needed for our pre-completed link 
manager edit form that will show up in front of the editor. After 
adding the fields, click OK to continue.

6.3.2 Revize Enable Products Area Navigation Using Link 
Manager

21. The first thing we need to do is put a Revize list in to list out all 
of our links. To do this place your cursor somewhere inside of 
your first row of the Left Navigation 
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On the bottom of the window menu click the “<tr>” to 
select this entire row. The example above should be how 
yours looks.  (Note:  actual words in the list may vary.) 

22. Click on the RZ.LIST button on the Revize object menu. When 
the Revize List screen appears make sure that all the fields 
are filled out as follows. 

Select & Fill In The Following: 
ListModule = links 

Sort By = linkseq 

Click OK. 

The Screen Should Look Something Like the Figure Below 
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6.3.3 Remove Hard coded Link In Order To Enable Int o 
Revize Link 

23. Select The “Brake Parts” link, then remove the hard coded link 
from the text by deleting the text in link area of Dreamweaver 
properties window 

Hard Code Link Example: 

<A href="products.html">Brake Parts</a>
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6.3.4 Revize Enable The Link Into A Revize Link  

24. Select the Brake Parts Text, click on RZ.Link from the Objects 
menu

25. When the Revize Link screen appears 

Select & Fill In The Following: 

Link Name = product_links (we need to give our set of 
links a name so Revize knows to open the link manager 
edit form) 

Click New Template  button: We need to create a place 
holder template for our editor to use to create new pages 
based on. We will enable a template with the same name 
in a few minutes. 
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6.3.5 Creating a Place Holder Template 

1. When the Create Place Holder window appears make sure that all 
the fields are filled out as follows. 

Select:

Template Type = Dependent Template 

Name = products_list_template 

Click OK.

The Place Holder allows you to pre-select a template that will later be created. 
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26. Click on the checkboxes: None, URL, and Upload File 

Click OK and continue. 

6.3.6 Adding Rz.Text Tag: Linkseq 

The checkboxes give the rights to the editor to select image, file, or 
standard text to be in place for the link displayed.



Dreamweaver Tutorial 

�¤ 2001-2002 Idetix Software Systems Page 129

27. Select Text in front of the links tag, (highlighted – actual text 
may read “product_links”), click Rz.text from your Revize 
Objects Menu.

Select & Fill In The Following: 

Module = links

Field = linkseq

your screen should appear like this: 

Make sure to Check Revize Text if login in the Dreamweaver 
Properties Box,before continuing. So that the sequence will only be 
seen when you are login not at any other time. 

6.3.7 Adding New, Edit and Delete 

28. To add the New button: 

Place your cursor in front of the Rz list tag, 
Click on the RZ_Button  object in the Dreamweaver 
objects palette. When the Revize button window appears.

Select:
List Item action = Add New List Item

Standard Revize Item = New (small) 

Click OK.
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To add the Edit  button: 
Place the cursor in front of links.seq. 

Click on the RZ_Button  object in the

Dreamweaver objects palette. When

the Revize button window appears.

Select:
List Item action = Edit this List Item

Standard Revize Item = Edit (small) 

Click OK.

To add the Delete  button: 
Place the cursor behind the edit button. 

Click on the RZ_Button  object in the Dreamweaver 
objects palette. When the Revize button window appears.

Select:
List Item action = Delete this List Item

Standard Revize Item = Delete (small) 

Click OK.

29. Store Updated Template . (Revize Enabling Step 7)
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30. Try out your new editable products.html page by going to:
http://localhost:8080/revize/tutorial/products.html  at this 
point you can add links to the list, but adding a page based on 
your place holder template won’t work because the template 
doesn’t exist. 

6.4 PRODUCTS LIST TEMPLATE – ENABLING YOUR PLACE

HOLDER TEMPLATE

1. Open product_list_template.html (Revize Enable Step #3)

6.4.1 Revize Enabling the Document (Revize Enable S tep 
#4)

31. With the product_list_template.html  open, click the REVIZE
menu, and select REVIZE ENABLE DOCUMENT.  When the 
Revize Enable screen appears make sure that all the fields are 
filled out as follows.
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Document Type = Dependent Template
Idetix webSpace = tutorial
Template Name = products_list_template

Path/Filename = product_link_template.html 

Dependent Module = links 

Click OK when finished.
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6.4.2 Copying the Enabled Link Manager List From 
products.rzt

32. Click inside the table for the left navigation. In the bottom area 
of the window menu, click the “<table>” to select this entire 
table.

33. Go back to products.rzt 

34. Select already enabled left navigation table from products.rzt

35. Copy this table from products.rzt., as shown in the picture on 
the right. See below for keyboard short cut if needed. 

Short Cut keyboard strokes:

Use “Ctrl + C”  to Copy 
Use “Ctrl + V to Paste 
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36. Repeat step 5 but in products_list.rzt . Click inside the table 
for the left navigation. In the bottom area of the window menu, 
click the “<table>” to select this entire row.

37.  Paste this table into the highlighted Left Navigation of 
product_list_template.rzt

6.4.3 Revize Enable Step 5: Create Module: 
products_template

We need to create a module for content that displays on each use 

of the products list template. Follow the steps below to complete 

this enabling step. 

38. Now, go to Create Modules and / or Fields , from the Revize 
Menu.
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Create a Module called products_template , include all the 
field names and types that are listed below. 

Field Names Field Type 

Name Text

Price Text 

Description Text 

Image Image 

Linked Number 

Note: The “linked” field is used to relate the links module 
with the products list module. Using this field to filter 
content later on will allow us to show different content on 
each use of the products list template.



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 136

The below figure is how it should look when you hav e completed 
entering the module, field names and types in Create Modules and 
/ or Fields window.
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6.4.4 Preparing Your Repeatable Table Row on the 
products_list_template

39. Step 10:
Place your cursor somewhere inside of your first row of the 
products_list_template

On the bottom of the window menu click the “<tr>” to 
select this entire row.
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6.4.5 Setting Up a Repeating List 

40. Once the first row is selected as shown above. 

Click on the RZ_LIST button in the Dreamweaver objects 
window.

When the Revize Enable screen appears make sure that all 
the fields are filled out as follows: 

List Module = products_template
Sort By = name

Filter List By = products_template.linkid = links._recordid 

Click OK to continue. 

Note: Again here we are telling you to filter the content by 
this page’s linkid number in order to separate the different 
versions of content that are displayed on each use of the 
product list template.
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Revize List Screen Shown Below: 
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Your screen should now look like this. At this point we are now ready 
to revize-enable our text, and image. 

6.4.6 Revize Enabling Text 

41. We now need to make the three text areas and picture of the 
product to be “Revize-Enabled”. We will start with the 
product .name first as an example, to complete the price and 
description repeat the process listed below.

Select the product name first.

Then, click on the RZ_TEXT object button in the 
Dreamweaver objects palette.

When the Revize Text window appears. 

Select the following: 

module = product_template

field name = name

click OK.
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This is how it should look when all three are entered.

6.4.7 Revize Enable Image 

42. Revize-Enabling our Image, Select the image, click Rz Image. 
Select the following choice: 

module name = product_template

field = image

click OK. 

From the revise menu select Store Updated Template. 

6.4.8 Adding New, Edit and Delete Buttons 

43. To add the New button: 

Place your cursor in the <td> before the title listing Name,
Click on the RZ_Button  object on the Dreamweaver objects 
palette. When the Revize button window appears.
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Select:
      List Item action = Add New List Item 

Standard Revize Item = New

Effected Module: products_template 

Related List Options: products_template.linkid = 
links._recordid

Click OK.
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To add the Edit  button: 
Place the cursor After products_template.description, 

Click on the RZ_Button  object in the Dreamweaver 
objects palette. When the Revize button window appears.

Select:
      List Item action = Edit this List Item

Standard Revize Item = Edit

Click OK.

To add the Delete  button: 
Place the cursor behind the edit button. 

Click on the RZ_Button  object in the Dreamweaver 
objects palette. When the Revize button window appears.

      Select:
      List Item action = Delete this List Item

Standard Revize Item = Delete

Note: When we added the new button to the template. We 
also need to add in the same filter criteria to the new button 
so that our list filter is automatically set when new products 
are put in. 
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Click OK.

Your products_list_template should now similar to t he figure
below:

44. Store Updated Template . (Revize Enabling Step 7)

45. Re-store the products.rzt template  as well so that the links 
list on the products.html will be updated to recognize that the 
place holder template has now been enabled. 

Try out your new link manager enabled list and temp late by 
going to: 

http://localhost:8080/revize/tutorial/products.html

Try adding in a new link based on the template called: 
product_list_template
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If you got link manager to add a new page for you, you are 
ready to move on to creating and edit form for your  
product_list_template.

6.4.9 Creating the products_list_template Editform (Revize 
Enabling Step 9) 

1. With the product_list_template.rzt  open, click the REVIZE menu, 
and select REVIZE ENABLE DOCUMENT.  When the Revize Enable 
screen appears, select Document type: Editform, click ok to
continue.

Click OK.



 Dreamweaver Tutorial 

�¤2001-2002 Idetix Software Systems Page 146



Dreamweaver Tutorial 

�¤ 2001-2002 Idetix Software Systems Page 147

6.4.10 Deleting List Tags and Buttons 

46. Delete all the Template buttons and Revize list tags on the Edit 
Form

Using your mouse, select each of the buttons  on the page 
and hit your delete key. This will delete all the buttons on the 
page.

Now select the Revize list tags  that you see above and 
below the products content table, and click on delete  to 
remove the tags from the page, since they are not needed on 
the edit form. 

6.4.11 Resized The Text area 

47.  Highlight product_template.description  text area, go to the 
properties Window. From the drop down window: Type select: 
Editable, Multi-line. 

Developer Tip:  You may want to add text above these form areas 
stating what they are. Because this is an Edit Form, the only way to 

know what the form represents is to mark it. 

The character width and Height may also be changed to better fix 
the page layout. 
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6.4.12 Adding Save and Cancel Buttons 

48. To add Save Button: 

Position the cursor in the table cell below the 
products_list.description

Click on RZ button  in the Revize object window 

Select:
Edit Form Action = Save Changes 

Standard Revize Item = Save

Click OK.

It should look like this when completed 
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Developer Note:  You may not like the way your Edit Form looks at 
this point; it may be a good idea to create a better-looking and better-

organized Edit Form at this stage. You can create the look above by 
adding in some table rows and then deleting some columns. After that 
you can move your objects around to where they are better suited. 
When completed it should look like the figure below: 

49. Save the newly created Editform. (File> Save)

50. Try to edit the page you created using link manager earlier by 
going to:
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http://localhost:8080/revize/tutorial/products.html

then clicking on a link you created to a template, and click 
on “New”.

6.5 REVIEW & TESTING:

At this point you should be able to add links to pages based on the 
product_list_template that you enabled, and then edit content on those 
pages. The content on each of the created pages should be different 
from the others, but should keep the same look and feel.

If for some reason that the links or pages don’t work correctly you may 
want to go and look at our pre-completed templates in the demositeIII 
webSpace. The most frequent error is forgetting to add the id filter to 
the new button or to the list on the product_list_template. 

If you have any comments or questions on link manager, please call us 
here at Idetix Software Systems.


